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जब तक कह  न ज ये,पसु्ततक  न खोलें । 

FIRST READ ALL THE INSTRUCTIONS / पहले सभी स्नदशेों dks पढ़ लें । 

Important Instructions / महत् वपू्ण  स्नदशे 

1. This paper consists of 100 multiple choice questions (M.C.Q.). All questions are 

Compulsory and carry 01 mark each. There is no negative marking. 

इस प्रश् न प्र  में 100 बहुस्वकल् पीय प्रश् न ह  । सभी प्रश् न अस्नव यण  ह  व प्रत् येक प्रश् न 01 अांक क  ह।ै गलत 

उत् तर के स्लए अांक नहीं क टे ज येंग।े 

2. Each question has four alternative responses marked (A), (B), (C) and (D). You 

have to choose an appropriate answer option and mark it on the OMR sheet. 

प्रत् येक प्रश् न के ा र उत् तर स्वकल् प (A), (B), (C) एव (D) स्दए गए ह  । आपको उपयकु् त उत् तर स्वकल् प 

क  ानु व कर mRrj vks-,e-vkj प्रप्र  पर अांस्कत करन  ह ै। 

3. For marking answers on OMR sheet, follow the detailed instructions given on the 

OMR Sheet. 

ओ0एम0आर0 प्रप्र  पर अपने सही उत् तर को स्ास्न्‍दहत करने के स्लए प्रप्र  पर अांस्कत स्नदशेों क  प लन 

 कीस्जए । 

4. Use only Blue or Black ball point pen for marking on OMR. 

ओ0एम0आर0 पर स्ान्‍द ह लग ने के स्लए केवल नीली य  क ली बॉल ्‍ वॉइन्‍द ट पनै क  ही इत तेम ल 

 कीस्जए। 
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1. What is the full form of DNS? 

A. Domain Naming Scheme 

B. Data Network Server 

C. Digital Number Service 

D. Domain Name System  

DNS का पूरा रूप क्या है? 

A. डोमेन नेममिंग स्कीम 

B. डेटा नेटवकक  सवकर 

C. मडमिटल निंबर समवकस 

D. डोमेन नेम मसस्टम  

 

2. Who developed the World Wide Web? 

A. Tim Berners-Lee 

B. Bill Gates 

C. Steve Jobs 

D. Mark Zuckerberg  

मवश्व व्यापी वेब (World Wide Web) मकसने मवकमसत मकया? 

A. मटम बनकसक-ली 

B. मबल गेट्स 

C. स्टीव िॉब्स 

D. माकक  िुकेरबगक  

 

3. What is meant by Cyber Crime? 

A. Crimes that occur only in the physical world. 

B. Illegal activities carried out using computers or the internet. 

C. Theft that happens in shops or markets. 

D. Activities related to online shopping.  

साइबर अपराध (Cyber Crime) से क्या अमभप्राय है? 

A. वे अपराध िो केवल भौमतक दुमनया में होते हैं। 

B. वे अवैध गमतमवमधयााँ िो किं पू्यटर या इिंटरनेट का उपयोग करके की िाती हैं। 

C. वे चोरी िो दुकानोिं या बािारोिं में होती हैं। 

D. ऑनलाइन शॉमपिंग से सिंबिंमधत गमतमवमधयााँ।  

 

4. Which of the following is NOT malware? 

A. Worm 

B. Virus 
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C. Trojan 

D. PDF File  

मनम्न में से कौन-सा मालवेयर नही िं है? 

A. वमक 

B. वायरस 

C. टर ोिन 

D. पीडीएफ फाइल  

 

5. What is the main purpose of browser hijacking software? 

A. To improve the quality of internet browsing. 

B. To redirect users to unwanted or malicious webpages. 

C. To increase the processing speed of the computer. 

D. To play music automatically.  

ब्राउज़र हाईिैमकिं ग सॉफ़्टवेयर का मुख्य उदे्दश्य क्या होता है? 

A. इिंटरनेट ब्राउमज़िंग की गुणवत्ता में सुधार करना 

B. उपयोगकताकओिं को अवािंमित या हामनकारक वेबपेिोिं पर रीडायरेक्ट करना 

C. किं पू्यटर की प्रोसेमसिंग स्पीड बढाना 

D. अपने-आप सिंगीत चलाना  

 

6. Cyber Stalking is a crime related to- 

A. Video editing. 

B. Downloading files 

C. Online harassment 

D. Printing  

साइबर स्टॉमकिं ग मकससे सिंबिंमधत अपराध है? 

A. वीमडयो एमडमटिंग 

B. फाइलें डाउनलोड करना 

C. ऑनलाइन उत्पीड़न 

D. मप्रिंमटिंग  

 

7. What is the primary goal of phishing attacks? 

A. Charging mobile batteries. 

B. Speeding up device performance. 

C. Sending deceptive messages to steal sensitive information. 

D. Installing system updates.  

मफमशिंग हमलोिं का मुख्य उदे्दश्य क्या होता है? 
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A. मोबाइल बैटरी चािक करना. 

B. मडवाइस का प्रदशकन बढाना 

C. सिंवेदनशील िानकारी चुराने के मलए भ्रामक सिंदेश भेिना 

D. मसस्टम अपडेट इिंस्टॉल करना  

 

8. What is a Logic Bomb? 

A. A hidden malicious program that activates when specific conditions are met 

B. A regular computer utility tool 

C. A physical explosive device. 

D. A harmless software update.  

लॉमिक बॉम्ब क्या होता है? 

A. एक मिपा हुआ हामनकारक प्रोग्राम िो मकसी मवशेष स्थथमत में समिय होता है 

B. सामान्य किं पू्यटर उपयोमगता उपकरण 

C. एक भौमतक मवस्फोटक उपकरण 

D. एक साधारण सॉफ़्टवेयर अपडेट  

 

9. What happens in Email Spoofing? 

A. The inbox storage is increased. 

B. The email's background color is modified. 

C. The email is automatically printed. 

D. A false sender address is used to deceive the recipient.  

Email Spoofing में क्या होता है? 

A. इनबॉक्स स्टोरेि बढ िाता है 

B. ईमेल की बैकग्राउिंड रिं ग बदला िाता है 

C. ईमेल अपने-आप मप्रिंट हो िाता है 

D. प्राप्तकताक को धोखा देने के मलए नकली पे्रषक पता उपयोग मकया िाता है  

 

10. What is the main purpose of a DoS (Denial of Service) attack? 

A. Overloading a system or service to make it unavailable. 

B. Improving the performance of a server. 

C. Cleaning unwanted files from a system. 

D. Enhancing network speed.  

DoS (सेवा मनषेध) हमले का मुख्य उदे्दश्य क्या है? 

A. मकसी मसस्टम या सेवा को ओवरलोड करके उसे अनुपलब्ध बनाना। 

B. सवकर के प्रदशकन में सुधार करना। 

C. मसस्टम से अवािंमित फाइलें हटाना। 
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D. नेटवकक  की गमत बढाना।  

 

11. What does "Data Diddling" refer to? 

A. Repairing computer hardware 

B. Unauthorized alteration of data before or during processing 

C. Formatting mobile devices 

D. No change to data  

"डेटा मडडमलिंग" मकसे कहते हैं? 

A. किं पू्यटर हाडकवेयर की मरम्मत 

B. प्रोसेस होने से पहले या दौरान डेटा में अनमधकृत बदलाव करना 

C. मोबाइल मडवाइस को फॉमेट करना 

D. डेटा में कोई बदलाव न करना  

 

12. What is the main purpose of authentication? 

A. To run games. 

B. To delete files. 

C. To verify the user's identity. 

D. To change system appearance.  

प्रमाणीकरण (Authentication) का मुख्य उदे्दश्य क्या होता है? 

A. गेम चलाना. 

B. फाइलें हटाना 

C. उपयोगकताक की पहचान की पुमि करना 

D. मसस्टम की मदखावट बदलना  

 

13. What does "Encryption" mean? 

A. Loading files into memory 

B. Displaying data on screen 

C. Transforming readable data into a secure, unreadable format 

D. Printing documents  

Encryption का क्या अथक है? 

A. फाइलोिं को मेमोरी में लोड करना 

B. डेटा को स्क्रीन पर मदखाना 

C. पढने योग्य डेटा को सुरमित, अपठनीय रूप में बदलना 

D. दस्तावेज़ोिं को मप्रिंट करना  

 

14. What does a Digital Signature verify? 
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A. Data integrity and the authenticity of the sender. 

B. Text colour settings 

C. Font style of the document 

D. Page layout design  

मडमिटल मसगे्नचर क्या सत्यामपत करता है? 

A. डेटा की अखिंडता और भेिने वाले की प्रामामणकता 

B. टेक्स्ट के रिंग सेमटिंग्स 

C. दस्तावेज़ के फॉन्ट शैली 

D. पेि लेआउट मडज़ाइन  

 

15. What is the primary purpose of an Antivirus? 

A. To detect and remove malware 

B. To record audio on the computer 

C. To increase the computer's RAM 

D. To adjust screen brightness  

Antivirus का मुख्य उदे्दश्य क्या होता है? 

A. हामनकारक सॉफ़्टवेयर (Malware) का पता लगाना और उसे हटाना 

B. किं पू्यटर में ऑमडयो ररकॉडक करना 

C. किं पू्यटर की RAM िमता बढाना 

D. मसस्टम की स्क्रीन ब्राइटनेस मनयिंमित करना  

 

16. A Firewall acts as a security barrier between- 

A. A computer's fan and CPU 

B. An internal network and external/untrusted networks. 

C. A keyboard and mouse connection 

D. A printer and scanner  

फायरवॉल मकसके बीच सुरिा अवरोध (Security Barrier) के रूप में कायक करता है? 

A. किं पू्यटर के फैन और CPU के बीच 

B. आिंतररक नेटवकक  और बाहरी/अमवश्वसनीय नेटवकक  के बीच 

C. कीबोडक और माउस कनेक्शन के बीच 

D. मप्रिंटर और सै्कनर के बीच  

 

17. What does Steganography hide? 

A. Wallpaper designs 

B. Secret data concealed inside images, audio, or other media 

C. Cooking recipes 
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D. Computer games  

से्टगनोग्राफी में क्या मिपाया िाता है? 

A. वॉलपेपर मडज़ाइन 

B. िमवयोिं, ऑमडयो या अन्य मीमडया के भीतर मिपाया गया गुप्त डाटा 

C. खाना बनाने की रेमसपी 

D. किं पू्यटर गेम्स  

 

18. What is the opposite process of Encryption? 

A. Code Formatting 

B. Data Rotation 

C. File Compression 

D. Decryption  

एस्रिप्शन की मवपरीत प्रमिया क्या होती है? 

A. कोड फॉमेमटिंग 

B. डेटा रोटेशन 

C. फाइल कमे्प्रशन 

D. मडमिप्शन  

 

19. What does Two-Factor Authentication (2FA) require for user login? 

A. Two different verification steps for confirming identity 

B. Two separate computers for accessing the account 

C. Two email accounts for registration 

D. Two keyboards connected to the device  

Two-Factor Authentication (2FA) में उपयोगकताक लॉमगन के मलए क्या आवश्यक होता है? 

A. पहचान की पुमि के मलए दो अलग-अलग सत्यापन चरण 

B. खाते तक पहुाँचने के मलए दो किं पू्यटर 

C. पिंिीकरण के मलए दो ईमेल खाते 

D. मडवाइस से िुडे़ दो कीकीबोडक  

 

20. What is the primary purpose of Cyber Forensics? 

A. To develop entertainment games 

B. To investigate cyber-crimes by collecting and examining digital evidence 

C. To produce digital music tracks 

D. To design graphical themes  

साइबर फॉरें मसक्स का मुख्य उदे्दश्य क्या होता है? 

A. मनोरिंिन के मलए गेम मवकमसत करना 
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B. मडमिटल साक्ष्ोिं को एकमित और िािंचकर साइबर अपराधोिं की िािंच करना 

C. मडमिटल मू्यमज़क टर ैक बनाना 

D. ग्रामफकल थीम्स मडज़ाइन करना  

 

21. Which cyber-crime involves tricking users into revealing personal information 

through fake websites or emails? 

A. Keylogging 

B. SQL Injection 

C. DDoS Attack 

D. Phishing  

कौन सा साइबर अपराध नकली वेबसाइट या ईमेल के माध्यम से उपयोगकताकओिं से व्यस्िगत 

िानकारी मनकलवाने से सिंबिंमधत है? 

A. की-लॉमगिंग. 

B. SQL इिंिेक्शन 

C. DDoS हमला 

D. मफमशिंग  

 

22. Which cyber-crime focuses on gaining unauthorized access to a system by 

exploiting software vulnerabilities? 

A. Hacking 

B. Cyber Bullying 

C. Social Engineering 

D. Data Backup  

कौन सा साइबर अपराध सॉफ़्टवेयर की कमिोररयोिं का फायदा उठाकर मसस्टम में अनमधकृत प्रवेश 

करने पर कें मित है? 

A. हैमकिं ग 

B. साइबर बुमलिंग 

C. सोशल इिंिीमनयररिंग 

D. डेटा बैकअप  

 

23. What is the primary goal of a Distributed Denial-of-Service (DDoS) attack? 

A. To modify system logs secretly. 

B. To steal personal banking information 

C. To overwhelm a server and make services unavailable 

D. To encrypt data for ransom  

Distributed Denial-of-Service (DDoS) हमले का मुख्य उदे्दश्य क्या होता है? 

A. मसस्टम लॉग को गुप्त रूप से बदलना. 
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B. बैंमकिं ग िानकारी चुराना 

C. सवकर को ओवरलोड करके सेवाओिं को अनुपलब्ध करना 

D. डेटा को मफरौती के मलए एस्रिप्ट करना  

 

24. What is the most important rule in digital evidence collection? 

A. Rearranging folders for convenience 

B. Editing images to enhance clarity 

C. Compressing files to reduce size 

D. Preserving the integrity of the evidence  

मडमिटल साक्ष् एकमित करने का सबसे महत्वपूणक मनयम क्या है? 

A. सुमवधा के मलए फोल्डरोिं को पुनः व्यवस्थथत करना. 

B. तस्वीरोिं को सिंपामदत करना 

C. फाइलोिं का आकार कम करने के मलए उन्हें कमे्प्रस करना 

D. साक्ष् की अखिंडता (Integrity) को सुरमित रखना  

 

25. Why is digital evidence considered volatile? 

A. It is physically heavy 

B. It can be easily altered or lost 

C. It is very costly to store 

D. It is stored in printed form  

मडमिटल साक्ष् को अस्थथर (volatile) क्योिं माना िाता है? 

A. यह भौमतक रूप से भारी होता है 

B. इसे आसानी से बदला या ममटाया िा सकता है 

C. इसे सिंग्रहीत करना बहुत महिंगा होता है 

D. यह मुमित रूप में सिंग्रहीत होता है  

 

26. Recent cyber-attacks generally target- 

A. Manual records. 

B. Internet data. 

C. Household documents. 

D. Critical information infrastructure.  

हाल के साइबर हमले सामान्यतः मकसे मनशाना बनाते हैं? 

A. मैनुअल ररकॉडक 

B. इिंटरनेट डेटा 

C. घरेलू दस्तावेज़ 

D. मिमटकल इिंफॉमेशन इिंफ्रास्टर क्चर  
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27. A cyber-attack that steals user data is known as 

A. Data Breach 

B. Data Cleaning 

C. Data Compression 

D. Data Formatting  

मिस साइबर हमले में उपयोगकताक का डेटा चुराया िाता है, उसे क्या कहा िाता है? 

A. डेटा ब्रीच (Data Breach) 

B. डेटा िीमनिंग 

C. डेटा कमे्प्रशन 

D. डेटा फॉमेमटिंग  

 

28. The primary objective of a ransomware attack is to 

A. Enhance graphics quality 

B. Increase system performance 

C. Lock data and demand payment 

D. Slows down the internet connection  

रैनसमवेयर हमले का मुख्य उदे्दश्य क्या होता है? 

A. ग्रामफक्स गुणवत्ता बढाना 

B. मसस्टम प्रदशकन बढाना 

C. डेटा को लॉक करना और पैसे की मािंग करना 

D. इिंटरनेट कनेक्शन को धीमा करना  

 

29. "WannaCry" is an example of- 

A. Ransomware 

B. Spyware 

C. Adware 

D. Keylogger  

"WannaCry" मकसका उदाहरण है? 

A. रैनसमवेयर 

B. स्पायवेयर 

C. ऐडवेयर 

D. कीलॉगर  

 

30. Recent cyber-attacks are rising mainly due to- 

A. Growing interest in travelling 
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B. Reduced newspaper reading habits 

C. Increased dependency on digital services 

D. Increased outdoor activities  

हाल के साइबर हमलोिं में वृस्ि मुख्य रूप से मकस कारण हो रही है? 

A. यािा में बढती रुमच 

B. अख़बार पढने की आदत में कमी 

C. मडमिटल सेवाओिं पर बढती मनभकरता 

D. बाहरी गमतमवमधयोिं में वृस्ि  

 

31. Cyber-crime incidents are reported to the- 

A. Local Police station. 

B. Cybercrime Cell / Cyber Police 

C. Interpole 

D. General Government office.  

साइबर अपराध की घटनाएाँ  मकसे ररपोटक की िाती हैं? 

A. थथानीय पुमलस से्टशन 

B. साइबरिाइम सेल / साइबर पुमलस 

C. इिंटरपोल 

D. सामान्य सरकारी कायाकलय  

 

32. The primary aim of India's Cyber Security Policy is to- 

A. Conduct internet awareness programmes 

B. Promote usage of digital services 

C. Boost agricultural production 

D. Secure and protect cyberspace  

भारत की साइबर सुरिा नीमत का मुख्य उदे्दश्य क्या है? 

A. इिंटरनेट िागरूकता कायकिम चलाना 

B. मडमिटल सेवाओिं के उपयोग को बढावा देना 

C. कृमष उत्पादन बढाना 

D. साइबर से्पस को सुरमित और सिंरमित करना  

 

33. CERT-In stands for- 

A. Computer Emergency Response Team-India 

B. Central Emergency Rescue Taskforce 

C. Cyber Expert Research Team 

D. Computer Education Resource Team  
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CERT-In का पूणक रूप क्या है? 

A. कम्प्पू्यटर इमरिेंसी ररस्पॉन्स टीम - इिं मडया 

B. सेंटर ल इमरिेंसी रेथकू्य टास्कफोसक 

C. साइबर एक्सपटक ररसचक टीम 

D. कम्प्पू्यटर एिुकेशन ररसोसक टीम  

 

34. The Cyber Surakshit Bharat Mission focuses on- 

A. Improving sports performance 

B. Promoting cyber hygiene and awareness 

C. Enhancing culinary skills 

D. Increasing tourist activities  

Cyber Surakshit Bharat Mission का मुख्य उदे्दश्य है 

A. खेल प्रदशकन में सुधार करना 

B. साइबर हाइिीन और िागरूकता को बढावा देना 

C. पाक-कौशल में सुधार करना 

D. पयकटन गमतमवमधयोिं को बढाना  

 

35. The National Cyber Coordination Centre (NCCC) monitors- 

A. Roadways traffic. 

B. Railway Traffic 

C. Weather forecasting systems 

D. Internet traffic and cyber threats  

नेशनल साइबर कोऑमडकनेशन सेंटर (NCCC) मकसकी मनगरानी करता है? 

A. सड़क यातायात 

B. रेलवे यातायात 

C. मौसम पूवाकनुमान प्रणाली 

D. इिंटरनेट टर ै मफक और साइबर खतरोिं की  

 

36. What is the primary purpose of clearing the browser cache? 

A. Increase internet bill 

B. Remove stored temporary files and improve browser performance 

C. Install new extensions 

D. Slow down the browser  

ब्राउज़र कैश को साफ करने का मुख्य उदे्दश्य क्या है? 

A. इिंटरनेट मबल बढाना 

B. अथथायी सिंग्रहीत फाइलोिं को हटाना और ब्राउज़र का प्रदशकन बेहतर करना 
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C. नए एक्सटेंशन इिंस्टॉल करना 

D. ब्राउज़र को धीमा करना  

 

37. When shopping online, which practice increases your safety? 

A. Using public Wi-Fi for payments 

B. Sharing OTP with trusted friends 

C. Purchasing only from reputed and verified websites 

D. Saving debit card details on all websites  

ऑनलाइन खरीदारी करते समय, कौन-सा अभ्यास आपकी सुरिा बढाता है? 

A. भुगतान के मलए पस्िक वाई-फाई का उपयोग करना 

B. भरोसेमिंद दोस्तोिं के साथ ओटीपी साझा करना 

C. केवल मवश्वसनीय और सत्यामपत वेबसाइटोिं से ही खरीदारी करना 

D. सभी वेबसाइटोिं पर डेमबट काडक मववरण सहेिना  

 

38. In Chrome browser versions 10 and above, how do you generally clear the cache? 

A. Settings → Clean Disk 

B. Settings → Privacy and Security → Clear browsing data 

C. File → Save Page As → Delete 

D. Tools → Exit  

िोम ब्राउज़र (सिंस्करण 10 और उससे ऊपर) में कैश कैसे साफ मकया िाता है? 

A. सेमटिंग्स → िीन मडस्क 

B. सेमटिंग्स → प्राइवेसी एिं ड मसक्योररटी → स्ियर ब्राउमज़िंग डेटा 

C. फाइल → सेव पेि ऐज़ → मडलीट 

D. टूल्स → एस्जज़ट  

 

39. In early Chrome versions (1 to 9), cache clearing was mainly done through: 

A. Preferences → Security → Remove Password 

B. Settings → Under the Hood → Clear browsing data 

C. Tools → Find → Delete 

D. Chrome Store → Cache Cleaner  

शुरुआती िोम सिंस्करणोिं (1 से 9) में, कैश साफ करना मुख्य रूप से इन तरीकोिं से मकया िाता थाः 

A. प्राथममकताएाँ  → सुरिा → पासवडक हटाएाँ  

B. सेमटिंग्स → अिंदरूनी िानकारी → ब्राउमज़िंग डेटा साफ करें  

C. टूल्स → ढूाँढें  → हटाएाँ  

D. िोम स्टोर → कैश िीनर  
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40. On Safari for iOS (iPhone/iPad), cache is cleared using: 

A. Settings → General → Reset iPhone 

B. iCloud → Delete Device 

C. Safari → File → Clear All 

D. Settings → Safari → Clear History and Website Data  

iOS (iPhone/iPad) के मलए Safari पर, कैशे साफ करने का तरीका इस प्रकार है: 

A. सेमटिंग्स → सामान्य → iPhone रीसेट करें  

B. iCloud → मडवाइस हटाएाँ  

C. Safari → फाइल → सभी साफ करें  

D. सेमटिंग्स → Safari → इमतहास और वेबसाइट डेटा साफ करें   

 

41. Cache clearing in Safari on macOS is commonly done by first enabling: 

A. Developer menu 

B. Spotlight Search 

C. Siri Search 

D. FileVault Disk Encryption  

macOS पर Safari में कैश साफ करने के मलए आमतौर पर सबसे पहले इन चीज़ोिं को सिम मकया 

िाता है: 

A. डेवलपर मेनू 

B. स्पॉटलाइट सचक 

C. मसरी सचक 

D. फाइलवॉल्ट मडस्क एस्रिप्शन  

 

42. Internet Explorer 9, 10, and 11 allow cache clearing from: 

A. Safety menu → Delete browsing history 

B. Task Manager → End Task 

C. Control Panel → Devices 

D. Windows Media Player settings  

इिंटरनेट एक्सप्लोरर 9, 10 और 11 कैश स्ियररिंग की सुमवधा देते हैं: 

A. सुरिा मेनू → ब्राउमज़िंग इमतहास ममटाएाँ  

B. कायक प्रबिंधक → कायक समाप्त करें  

C. मनयिंिण कि → उपकरण 

D. मविंडोज़ मीमडया पे्लयर सेमटिंग्स  

 

43. In Firefox (including Firefox 33), the cache can be cleared from: 

A. File → New Window 
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B. Options → Privacy → Clear recent history 

C. Tools → Bookmark Manager 

D. Downloads → Delete  

फायरफॉक्स (फायरफॉक्स 33 समहत) में, कैश को इन तरीकोिं से साफ मकया िा सकता है: 

A. फाइल → नई मविंडो 

B. मवकल्प → गोपनीयता → हाल का इमतहास साफ करें  

C. उपकरण → बुकमाकक  प्रबिंधक 

D. डाउनलोड → हटाएिं   

 

44. CCleaner is primarily used for: 

A. Updating operating systems 

B. Cleaning temporary files, cache, and optimizing system performance 

C. Designing websites 

D. Installing antivirus  

CCleaner का मुख्य रूप से उपयोग मनम्न के मलए मकया िाता है: 

A. ऑपरेमटिंग मसस्टम अपडेट करना 

B. अथथायी फाइलें, कैश साफ करना और मसस्टम प्रदशकन को अनुकूमलत करना 

C. वेबसाइट मडज़ाइन करना 

D. एिं टीवायरस इिंस्टॉल करना  

 

45. Which of the following is responsible for translating domain names into IP 

addresses? 

A. URL Server 

B. DNS 

C. SMTP 

D. FTP  

मनम्नमलस्खत में से कौन डोमेन नामोिं को आईपी पतोिं में बदलने के मलए मज़मे्मदार है? 

A. URL सवकर 

B. DNS 

C. SMTP 

D. FTP  

 

46. An IP address is best described as: 

A. A physical machine label 

B. A type of digital certificate 

C. A browser security code 
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D. A numerical identifier for devices on a network  

IP पते का सबसे अच्छा वणकन इस प्रकार मकया िा सकता है: 

A. एक भौमतक मशीन लेबल 

B. एक प्रकार का मडमिटल प्रमाणपि 

C. एक ब्राउज़र सुरिा कोड 

D. नेटवकक  पर उपकरणोिं के मलए एक सिंख्यात्मक पहचानकताक  

 

47. Which protocol is most commonly used to transfer web pages on the Internet? 

A. FTP 

B. SMTP 

C. HTTP 

D. Telnet  

इिंटरनेट पर वेब पेिोिं को थथानािंतररत करने के मलए सबसे अमधक इसे्तमाल मकया िाने वाला प्रोटोकॉल 

कौन सा है? 

A. FTP 

B. SMTP 

C. HTTP 

D. टेलनेट  

 

48. The main purpose of Internet Infrastructure is to: 

A. Provide printing services 

B. Manage screen resolution 

C. Display website themes 

D. Support global connectivity and data exchange  

इिंटरनेट इरफ्रास्टर क्चर का मुख्य उदे्दश्य है: 

A. मप्रिंमटिंग सेवाएाँ  प्रदान करना 

B. स्क्रीन ररज़ॉलू्यशन प्रबिंमधत करना 

C. वेबसाइट थीम प्रदमशकत करना 

D. वैमश्वक कनेस्क्टमवटी और डेटा एक्सचेंि का समथकन करना  

 

49. Which of the following is NOT a form of malware? 

A. Adware 

B. Spyware 

C. Worm 

D. Firewall  

मनम्नमलस्खत में से कौन मैलवेयर का एक रूप नही िं है? 
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A. एडवेयर 

B. स्पाइवेयर 

C. वमक 

D. फायरवॉल  

 

50. A malware that secretly collects user information and sends it to a remote 

attacker is called: 

A. Adware 

B. Spyware 

C. Worm 

D. Cookie  

एक मैलवेयर िो गुप्त रूप से उपयोगकताक की िानकारी एकि करता है और उसे दूरथथ हमलावर को 

भेिता है, उसे कहते हैं: 

A. एडवेयर 

B. स्पाइवेयर 

C. वमक 

D. कुकी  

 

51. A Trojan Horse typically: 

A. Replicates itself aggressively 

B. Repairs system files 

C. Appears legitimate but performs malicious actions 

D. Works only offline  

एक टर ोिन हॉसक आम तौर पर- 

A. खुद को तेिी से कॉपी करता है 

B. मसस्टम फाइलोिं की मरम्मत करता है 

C. वैध मदखता है लेमकन हामनकारक कायक करता है 

D. केवल ऑफलाइन काम करता है  

 

52. Browser Hijacking Software is used to: 

A. Increase browser speed 

B. Modify browser settings without permission 

C. Automatically clear cache 

D. Encrypt user data  

Browser Hijacking Software का उपयोग मकस मलए मकया िाता है? 

A. ब्राउज़र की गमत बढाने के मलए 

B. मबना अनुममत ब्राउज़र सेमटिंग्स बदलने के मलए 
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C. स्वचामलत रूप से कैश साफ करने के मलए 

D. उपयोगकताक डेटा एस्रिप्ट करने के मलए  

 

53. Scareware manipulates users by: 

A. Showing fake warnings to force unnecessary actions 

B. Encrypting personal files 

C. Updating antivirus software 

D. Speeding up hardware  

Scareware उपयोगकताकओिं को इस प्रकार प्रभामवत करता है- 

A. नकली चेतावमनयााँ मदखाकर अनावश्यक कायक करने के मलए मिबूर करना 

B. व्यस्िगत फाइलोिं को एस्रिप्ट करना 

C. एिं टीवायरस सॉफ़्टवेयर अपडेट करना 

D. हाडकवेयर की गमत बढाना  

 

54. Software Piracy refers to: 

A. Buying licensed software 

B. Using or distributing software without authorization 

C. Encrypting software 

D. Testing trial versions  

Software Piracy का अथक है- 

A. लाइसेंस प्राप्त सॉफ़्टवेयर खरीदना 

B. मबना अनुममत सॉफ़्टवेयर का उपयोग या मवतरण करना 

C. सॉफ़्टवेयर को एस्रिप्ट करना 

D. टर ायल वज़कन का परीिण करना  

 

55. Logic Bombs are malicious programs that: 

A. Execute only when triggered by a specific condition 

B. Heal infected files 

C. Spread only via email 

D. Require manual installation  

लॉमिक बम दुभाकवनापूणक प्रोग्राम होते हैं िोः 

A. केवल मकसी मवमशि स्थथमत द्वारा मटर गर होने पर ही मियास्ित होते हैं 

B. सिंिममत फाइलोिं को ठीक करते हैं 

C. केवल ईमेल के माध्यम से फैलते हैं 

D. मैनु्यअल इिंस्टॉलेशन की आवश्यकता होती है  
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56. Cyber Squatting involves: 

A. Hacking wireless signals 

B. Registering domain names similar to popular brands 

C. Crashing servers 

D. Encrypting DNS records  

साइबर स्क्वामटिंग में शाममल हैं: 

A. वायरलेस मसग्नल हैक करना 

B. लोकमप्रय ब्रािंडोिं से ममलते-िुलते डोमेन नाम पिंिीकृत करना 

C. सवकर िैश करना 

D. DNS ररकॉड्कस को एस्रिप्ट करना  

 

57. Salami Attack refers to: 

A. Small, repeated thefts that go unnoticed individually 

B. Large-scale financial fraud 

C. Physical destruction of servers 

D. Encrypting entire databases  

सलामी हमले से तात्पयक है: 

A. िोटी, बार-बार होने वाली चोररयााँ िो व्यस्िगत रूप से ध्यान में नही िं आती िं 

B. बडे़ पैमाने पर मवत्तीय धोखाधड़ी 

C. सवकरो िं का भौमतक मवनाश 

D. सिंपूणक डेटाबेस को एस्रिप्ट करना  

 

58. Email Spoofing involves: 

A. Encrypting emails for protection 

B. Faking the sender's email identity 

C. Blocking incoming messages 

D. Deleting inbox folders  

ईमेल सू्पमफिं ग में शाममल हैं: 

A. सुरिा के मलए ईमेल एस्रिप्ट करना 

B. पे्रषक की ईमेल पहचान को फिी बनाना 

C. आने वाले सिंदेशोिं को िॉक करना 

D. इनबॉक्स फोल्डसक को हटाना  

 

59. Which of the following is the first step in ensuring smartphone security? 

A. Installing games 

B. Using public Wi-Fi 
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C. Changing wallpaper 

D. Setting a strong screen lock (PIN/Pattern/Password)  

स्माटकफोन सुरिा सुमनमित करने के मलए मनम्नमलस्खत में से कौन सा पहला कदम है? 

A. गेम इिंस्टॉल करना 

B. सावकिमनक वाई-फाई का उपयोग करना 

C. वॉलपेपर बदलना 

D. एक मिबूत स्क्रीन लॉक (मपन/पैटनक/पासवडक) सेट करना  

 

60. A "locked smartphone" generally refers to: 

A. A phone that cannot be carried outside 

B. A device tied to a specific telecom operator 

C. A phone without a battery 

D. An encrypted device  

एक "लॉक्ड स्माटकफोन" आमतौर पर मनम्न को सिंदमभकत करता है: 

A. एक ऐसा फोन मिसे बाहर नही िं ले िाया िा सकता 

B. एक मवमशि दूरसिंचार ऑपरेटर से िुड़ा उपकरण 

C. मबना बैटरी वाला फोन 

D. एक एस्रिपे्टड मडवाइस  

 

61. Which mobile OS is known for its open-source architecture? 

A. iOS 

B. Windows Phone 

C. Android 

D. Symbian  

कौन सा मोबाइल ऑपरेमटिंग मसस्टम अपने ओपन-सोसक आमकक टेक्चर के मलए िाना िाता है? 

A. iOS 

B. मविंडोि फोन 

C. एिं डर ॉइड 

D. मसस्म्बयन  

 

62. Feature phones differ from smartphones mainly because they: 

A. Have better cameras 

B. Use only iOS 

C. Provide unlimited storage 

D. Do not support advanced apps and Internet browsing  

फीचर फोन स्माटकफोन से मुख्यतः इसमलए मभन्न होते हैं क्योिंमकः 
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A. बेहतर कैमरे होते हैं 

B. केवल iOS इसे्तमाल करते हैं 

C. असीममत स्टोरेि प्रदान करते हैं 

D. उन्नत ऐप्स और इिंटरनेट ब्राउमज़िंग का समथकन नही िं करते  

 

63. During initial setup of a smartphone, it is recommended to: 

A. Disable automatic updates 

B. Avoid setting a backup email 

C. Install apps from unknown websites 

D. Connect to a secure Wi-Fi network  

स्माटकफोन के शुरुआती सेटअप के दौरान, यह सलाह दी िाती है: 

A. स्वचामलत अपडेट अिम करें  

B. बैकअप ईमेल सेट करने से बचें 

C. अज्ञात वेबसाइटोिं से ऐप्स इिंस्टॉल करें  

D. सुरमित वाई-फाई नेटवकक  से कनेक्ट करें   

 

64. Installing applications should ideally be done through: 

A. Third-party APK sites 

B. Trusted app stores (Google Play Store / Apple App Store) 

C. Unknown links shared via SMS 

D. Browser pop-ups  

एस्प्लकेशन इिंस्टॉल करना आदशक रूप से मनम्नमलस्खत माध्यमोिं से मकया िाना चामहए: 

A. तृतीय-पि APK साइट्स 

B. मवश्वसनीय ऐप स्टोर (Google Play Store / Apple App Store) 

C. SMS के माध्यम से साझा मकए गए अज्ञात मलिंक 

D. ब्राउज़र पॉप-अप  

 

65. Updating applications regularly helps in: 

A. Fixing vulnerabilities and improving security 

B. Increasing screen brightness 

C. Removing all notifications 

D. Deleting media files  

मनयममत रूप से एस्प्लकेशन अपडेट करने से मनम्नमलस्खत में मदद ममलती है: 

A. कमज़ोररयोिं को ठीक करना और सुरिा में सुधार करना 

B. स्क्रीन की चमक बढाना 

C. सभी सूचनाएाँ  हटाना 
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D. मीमडया फाइलें हटाना  

 

66. Sending messages securely generally means: 

A. Using social media comments 

B. Sending plain SMS 

C. Using end-to-end encrypted messaging apps 

D. Sharing screenshots  

सुरमित रूप से सिंदेश भेिने का सामान्यतः अथक है: 

A. सोशल मीमडया मटप्पमणयोिं का उपयोग करना 

B. साधारण एसएमएस भेिना 

C. एिं ड-टू-एिं ड एस्रिपे्टड मैसेमििंग ऐप्स का उपयोग करना 

D. स्क्रीनशॉट साझा करना  

 

67. What is the safest place to store sensitive information on a smartphone? 

A. Photo gallery 

B. Notes without a password 

C. Encrypted secure folders/storage 

D. Social media drafts  

स्माटकफोन पर सिंवेदनशील िानकारी सिंग्रहीत करने के मलए सबसे सुरमित थथान कौन सा है? 

A. फोटो गैलरी 

B. मबना पासवडक वाले नोट्स 

C. एस्रिपे्टड सुरमित फोल्डर/स्टोरेि 

D. सोशल मीमडया डर ाफ्ट  

 

68. When sending email from a smartphone, users should: 

A. Use secure email apps and strong passwords. 

B. Avoid enabling two-factor authentication 

C. Save passwords in plain text 

D. Share OTPs for verification  

स्माटकफोन से ईमेल भेिते समय, उपयोगकताकओिं को ये करना चामहए: 

A. सुरमित ईमेल ऐप्स और मज़बूत पासवडक का उपयोग करें । 

B. दो-कारक प्रमाणीकरण सिम करने से बचें। 

C. पासवडक को सादे टेक्स्ट में सेव करें । 

D. सत्यापन के मलए OTP साझा करें ।  

 

 



23 

A-1161 P.T.O. 

69. Before capturing media that contains sensitive information, a user should: 

A. Disable device security 

B. Ensure the storage is encrypted 

C. Share the photo on social media 

D. Turn off file permissions  

सिंवेदनशील िानकारी वाले मीमडया को कैप्चर करने से पहले, उपयोगकताक को यह करना चामहए: 

A. मडवाइस सुरिा अिम करें  

B. सुमनमित करें  मक स्टोरेि एस्रिपे्टड है 

C. फोटो को सोशल मीमडया पर साझा करें  

D. फाइल अनुममतयााँ बिंद करें   

 

70. Which feature provides strong protection if the phone is stolen? 

A. Full-disk encryption. 

B. Airplane mode 

C. Silent mode 

D. Auto rotate  

Qksu pksjh gksus ij dkSu lk Qhpj etcwr lqj{kk iznku djrk gS\ 

A. फुल-मडस्क एस्रिप्शन 

B. एयरपे्लन मोड 

C. साइलेंट मोड 

D. ऑटो रोटेट  

 

71. A major characteristics of modern cyber-crimes is that they are often: 

A. Fully visible to victims 

B. Faster, global, and difficult to trace 

C. Possible only in offices 

D. Performed without internet  

आधुमनक साइबर अपराधोिं की एक प्रमुख मवशेषता यह है मक वे अक्सरः 

A. पीमड़तोिं को पूरी तरह मदखाई देते हैं 

B. तेज़, वैमश्वक और पता लगाना मुस्िल होते हैं 

C. केवल कायाकलयोिं में ही सिंभव होते हैं 

D. मबना इिंटरनेट के मकए िाते हैं  

 

72. Which of the following is an example of a recent cyber-crime incident? 

A. Ransomware attacks on hospitals and corporations 

B. ATM withdrawal. 
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C. Manual filing of data 

D. Local electricity repair  

मनम्नमलस्खत में से कौन सा हाल ही में हुई साइबर अपराध घटना का उदाहरण है? 

A. अस्पतालोिं और मनगमोिं पर रैनसमवेयर हमले 

B. एटीएम से पैसे मनकालना 

C. डेटा की मैनु्यअल फाइमलिंग 

D. थथानीय मबिली मरम्मत  

 

73. Data breaches in recent years primarily target: 

A. Offline records 

B. Manual files 

C. Weather stations 

D. Digital databases containing personal information  

हाल के वषों में डेटा उल्लिंघनोिं का मुख्य लक्ष् हैं: 

A. ऑफलाइन ररकॉडक 

B. मैनु्यअल फाइलें 

C. मौसम कें ि 

D. व्यस्िगत िानकारी वाले मडमिटल डेटाबेस  

 

74. A common reason for the rise of cyber-crime is: 

A. Slow internet speed 

B. Increased digital dependence 

C. Lack of social media platforms 

D. Reduction in device usage  

साइबर अपराध में वृस्ि का एक सामान्य कारण है: 

A. धीमी इिंटरनेट स्पीड 

B. मडमिटल मनभकरता में वृस्ि 

C. सोशल मीमडया पे्लटफॉमक का अभाव 

D. मडवाइस के उपयोग में कमी  

 

75. In India, which agency acts as the national nodal agency for cyber-security? 

A. IRCTC 

B. CERT-In 

C. UIDAI 

D. RBI  

भारत में, साइबर सुरिा के मलए रािर ीय नोडल एिेंसी के रूप में कौन सी एिेंसी कायक करती है? 
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A. IRCTC 

B. CERT-In 

C. UIDAI 

D. RBI  

 

76. Cyber Swachhta Kendra is mainly established for: 

A. Cleaning old computers 

B. Hosting government websites 

C. Providing social media training 

D. Botnet cleaning and malware analysis  

साइबर स्वच्छता कें ि मुख्यतः मनम्नमलस्खत के मलए थथामपत मकया गया है: 

A. पुराने किं पू्यटरोिं की सफाई 

B. सरकारी वेबसाइटोिं की होस्स्टिंग 

C. सोशल मीमडया प्रमशिण प्रदान करना 

D. बॉटनेट सफाई और मैलवेयर मवशे्लषण  

 

77. Which Indian law amendment strengthened cyber-crime penalties and data 

protection? 

A. IT Act 2000 Amendment 2008 

B. Company Act 2013 

C. Income Tax Amendment 2020 

D. Consumer Protection Act  

मकस भारतीय कानून सिंशोधन ने साइबर अपराध दिंड और डेटा सुरिा को मज़बूत मकया? 

A. आईटी अमधमनयम 2000 सिंशोधन 2008 

B. किं पनी अमधमनयम 2013 

C. आयकर सिंशोधन 2020 

D. उपभोिा सिंरिण अमधमनयम  

 

78. "Cyber Forensics Labs" in India are used for: 

A. Repairing damaged laptops 

B. Photo editing 

C. Investigating and preserving digital evidence 

D. Teaching computer basics only  

भारत में "साइबर फोरें मसक लैब" का उपयोग मनम्नमलस्खत के मलए मकया िाता है: 

A. िमतग्रस्त लैपटॉप की मरम्मत 

B. फोटो सिंपादन 
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C. मडमिटल साक्ष् की िााँच और सिंरिण 

D. केवल किं पू्यटर की मूल बातें पढाना  

 

79. A counter-cyber-security initiative that helps report cyber-crime in India is: 

A. 100 emergency number 

B. National Cybercrime Reporting Portal (www.cybercrime.gov.in) 

C. Postal department website 

D. School education portal  

भारत में साइबर अपराध की ररपोटक करने में मदद करने वाली एक साइबर-सुरिा पहल है: 

A. 100 आपातकालीन निंबर 

B. रािर ीय साइबर अपराध ररपोमटिंग पोटकल (www.cybercrime.gov.in) 

C. डाक मवभाग की वेबसाइट 

D. सू्कल मशिा पोटकल  

 

80. The major challenge in managing cyber-crime incidents is: 

A. Rapid evolution of malware and attack methods 

B. Low number of devices 

C. High-speed internet 

D. Strong passwords used everywhere  

साइबर अपराध की घटनाओिं के प्रबिंधन में प्रमुख चुनौमतयााँ हैं: 

A. मैलवेयर और हमले के तरीकोिं का तेज़ी से मवकास 

B. उपकरणोिं की कम सिंख्या 

C. तेज़ गमत वाला इिंटरनेट 

D. हर िगह इसे्तमाल होने वाले मज़बूत पासवडक  

 

81. Password managers are primarily used to: 

A. Share passwords publicly 

B. Store and manage complex passwords securely 

C. Disable device security 

D. Delete all login information  

पासवडक मैनेिर मुख्यतः मनम्नमलस्खत के मलए उपयोग मकए िाते हैं: 

A. पासवडक सावकिमनक रूप से साझा करना 

B. िमटल पासवडक को सुरमित रूप से सिंग्रहीत और प्रबिंमधत करना 

C. मडवाइस सुरिा अिम करना 

D. सभी लॉमगन िानकारी हटाना  
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82. A commonly used second factor in two-step verification is: 

A. OTP sent to phone/email 

B. Reading a PDF 

C. Restarting the device 

D. Updating wallpaper  

मद्व-चरणीय सत्यापन में आमतौर पर इसे्तमाल मकया िाने वाला दूसरा कारक है: 

A. फोन/ईमेल पर भेिा गया OTP 

B. PDF पढना 

C. मडवाइस को पुनः प्रारिंभ करना 

D. वॉलपेपर अपडेट करना  

 

83. Free antivirus software helps users by: 

A. Removing operating systems 

B. Increasing spam 

C. Detecting and removing basic malware 

D. Deleting all documents  

मुफ़्त एिं टीवायरस सॉफ़्टवेयर उपयोगकताकओिं की मदद इस प्रकार करता है: 

A. ऑपरेमटिंग मसस्टम हटाकर 

B. सै्पम बढाना 

C. बुमनयादी मैलवेयर का पता लगाकर उन्हें हटाना 

D. सभी दस्तावेज़ोिं को हटाना  

 

84. Windows Firewall primarily protects a system by: 

A. Speeding up system performance 

B. Changing keyboard layout. 

C. Deleting files automatically 

D. Allowing and blocking network traffic based on rules  

मविंडोज़ फायरवॉल मुख्य रूप से मसस्टम की सुरिा इस प्रकार करता है: 

A. मसस्टम के प्रदशकन को तेज़ करके 

B. कीबोडक लेआउट बदलकर। 

C. फाइलोिं को स्वचामलत रूप से हटाकर 

D. मनयमोिं के आधार पर नेटवकक  टर ै मफक को अनुममत देकर और िॉक करके  

 

85. "Inbound Rules" in Windows Firewall manage: 

A. Traffic going out of the computer 

B. Brightness levels 
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C. Traffic coming into the computer 

D. USB device functioning  

मविंडोि फायरवॉल में "इनबाउिंड मनयम" मनम्नमलस्खत का प्रबिंधन करते हैं: 

A. किं पू्यटर से बाहर िाने वाला टर ै मफक 

B. ब्राइटनेस लेवल 

C. किं पू्यटर में आने वाला टर ै मफक 

D. USB मडवाइस की कायकप्रणाली  

 

86. "Outbound Rules" in Windows Firewall control: 

A. Incoming data packets 

B. Outgoing data packets 

C. Mouse speed 

D. Display resolution  

मविंडोज़ फायरवॉल मनयिंिण में "आउटबाउिंड मनयम": 

A. इनकममिंग डेटा पैकेट 

B. आउटगोइिंग डेटा पैकेट 

C. माउस की गमत 

D. मडथपे्ल ररज़ॉलू्यशन  

 

87. Windows Firewall with Advanced Security can be opened using: 

A. Run → wf.msc 

B. Run → calc.exe 

C. Run → notepad.exe 

D. Run → explorer.exe  

उन्नत सुरिा के साथ Windows फायरवॉल को मनम्न का उपयोग करके खोला िा सकता है: 

A. Run → wf.msc 

B. Run → calc.exe 

C. Run → notepad.exe 

D. Run → explorer.exe  

 

88. Connection Security Rules are used to: 

A. Secure network connections using authentication or encryption 

B. Improve sound quality 

C. Change wallpaper 

D. Organize files  

कनेक्शन सुरिा मनयमोिं का उपयोग मनम्नमलस्खत के मलए मकया िाता है: 
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A. प्रमाणीकरण या एस्रिप्शन का उपयोग करके नेटवकक  कनेक्शन सुरमित करना 

B. ध्वमन की गुणवत्ता में सुधार करना 

C. वॉलपेपर बदलना 

D. फाइलें व्यवस्थथत करना  

 

89. The firewall monitor in Windows Firewall with Advanced Security shows: 

A. Only system brightness 

B. Active firewall rules and current network status 

C. List of installed movies 

D. Battery usage report  

उन्नत सुरिा वाले Windows फायरवॉल में फायरवॉल मॉमनटर मदखाता है: 

A. केवल मसस्टम ब्राइटनेस 

B. समिय फायरवॉल मनयम और वतकमान नेटवकक  स्थथमत 

C. इिंस्टॉल की गई मूवीज़ की सूची 

D. बैटरी उपयोग ररपोटक  

 

90. When selecting the best browser, the most important factor is: 

A. Number of available themes 

B. Size of the browser icon 

C. User's specific requirements (speed, security, extensions) 

D. Colour of the interface  

सवकशे्रष्ठ ब्राउज़र चुनते समय, सबसे महत्वपूणक कारक हैं: 

A. उपलब्ध थीम की सिंख्या 

B. ब्राउज़र आइकन का आकार 

C. उपयोगकताक की मवमशि आवश्यकताएाँ  (गमत, सुरिा, एक्सटेंशन) 

D. इिंटरफेस का रिंग  

 

91. Which browser is known for strong privacy features and tracking protection? 

A. Internet Explorer 

B. Mozilla Firefox 

C. Classic Netscape 

D. Opera Mini (Java version)  

कौन सा ब्राउज़र मज़बूत गोपनीयता सुमवधाओिं और टर ै मकिं ग सुरिा के मलए िाना िाता है? 

A. इिंटरनेट एक्सप्लोरर 

B. मोमिला फायरफॉक्स 

C. िामसक नेटसे्कप 
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D. ओपेरा ममनी (िावा सिंस्करण)  

 

92. For users who prefer speed and Google integration, the recommended browser 

is: 

A. Safari (Windows edition) 

B. Tor Browser 

C. Netscape Navigator 

D. Google Chrome  

िो उपयोगकताक गमत और Google एकीकरण पसिंद करते हैं, उनके मलए अनुशिंमसत ब्राउज़र है: 

A. सफारी (मविंडोज़ सिंस्करण) 

B. टोर ब्राउज़र 

C. नेटसे्कप नेमवगेटर 

D. गूगल िोम  

 

93. For maximum anonymity and privacy-focused browsing, users often choose: 

A. Tor Browser 

B. Basic Text Browser 

C. Classic Opera 

D. Internet Explorer 8  

अमधकतम गुमनामी और गोपनीयता-कें मित ब्राउमज़िंग के मलए, उपयोगकताक अक्सर चुनते हैं: 

A. टोर ब्राउज़र 

B. बेमसक टेक्स्ट ब्राउज़र 

C. िामसक ओपेरा 

D. इिंटरनेट एक्सप्लोरर 8  

 

94. Smartphone updates primarily help in--- 

A. Fixing security vulnerabilities and enhancing overall device protection 

B. Increasing promotional advertisements across applications 

C. Automatically installing harmful software 

D. Reducing built-in safety features of the operating system  

स्माटकफोन अपडेट मुख्य रूप से मनम्नमलस्खत में मदद करते हैं 

A. सुरिा कमज़ोररयोिं को ठीक करना और समग्र मडवाइस सुरिा को बेहतर बनाना 

B. सभी एस्प्लकेशन में प्रचार मवज्ञापनोिं को बढाना 

C. हामनकारक सॉफ़्टवेयर को स्वचामलत रूप से इिंस्टॉल करना 

D. ऑपरेमटिंग मसस्टम की अिंतमनकमहत सुरिा सुमवधाओिं को कम करना  
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95. Branded and carrier-locked smartphones typically provide- 

A. Operate without requiring any carrier authorization or SIM validation 

B. Allow installation of all applications without any limitations 

C. Provide completely unrestricted access to all network and device settings 

D. Limited installation  

ब्रािंडेड और कैररयर-लॉक वाले स्माटकफोन आमतौर पर क्या प्रदान करते हैं- 

A. मबना मकसी कैररयर प्रामधकरण या मसम सत्यापन की आवश्यकता के सिंचामलत होते हैं 

B. मबना मकसी सीमा के सभी एस्प्लकेशन इिंस्टॉल करने की अनुममत देते हैं 

C. सभी नेटवकक  और मडवाइस सेमटिंग्स तक पूरी तरह से अप्रमतबिंमधत पहुाँच प्रदान करते हैं 

D. सीममत इिंस्टॉलेशन  

 

96. Which of the following represents commonly used smartphone operating 

systems? 

A. Google Chrome and Microsoft Edge 

B. Microsoft Word and Adobe Photoshop 

C. Android and iOS 

D. ZIP Extractor and Media Player  

मनम्नमलस्खत में से कौन सा सामान्यतः प्रयुि स्माटकफोन ऑपरेमटिंग मसस्टम को दशाकता है? 

A. गूगल िोम और माइिोसॉफ्ट एि 

B. माइिोसॉफ्ट वडक और एडोब फोटोशॉप 

C. एिं डर ॉइड और iOS 

D. मज़प एक्सटर ैक्टर और मीमडया पे्लयर  

 

97. From where should users ideally install mobile applications to ensure security? 

A. Trusted official app stores such as Google Play Store or Apple App Store 

B. Random websites offering free application downloads 

C. Links received through unsolicited emails or messages 

D. Pop-up advertisements claiming to provide premium apps  

सुरिा सुमनमित करने के मलए उपयोगकताकओिं को मोबाइल एस्प्लकेशन कहााँ से इिंस्टॉल करने चामहए? 

A. मवश्वसनीय आमधकाररक ऐप स्टोर िैसे Google Play Store या Apple App Store 

B. मुफ़्त एस्प्लकेशन डाउनलोड की पेशकश करने वाली यादृस्च्छक वेबसाइटें 

C. अनचाहे ईमेल या सिंदेशोिं के माध्यम से प्राप्त मलिंक 

D. प्रीममयम ऐप प्रदान करने का दावा करने वाले पॉप-अप मवज्ञापन  

 

98. Photo sharing online should be- 

A. Uploaded automatically. 
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B. Shared with everyone 

C. Posted without checking privacy 

D. Controlled and selective  

ऑनलाइन फोटो साझा करना चामहए- 

A. स्वचामलत रूप से अपलोड मकया िाना चामहए। 

B. सभी के साथ साझा मकया िाना चामहए। 

C. गोपनीयता की िााँच मकए मबना पोस्ट मकया िाना चामहए। 

D. मनयिंमित और चयनात्मक होना चामहए।  

 

99. Social media groups should be joined- 

A. Without checking details 

B. After verifying their purpose 

C. Just because friends joined 

D. Forwards-based groups only  

सोशल मीमडया गु्रप्स में शाममल होना चामहए- 

A. मबना मववरण की िााँच मकए 

B. उनके उदे्दश्य की पुमि करने के बाद 

C. मसफक  इसमलए मक दोस्त शाममल हुए हैं 

D. केवल फॉरवडक-आधाररत गु्रप्स  

 

100. Posting live location is- 

A. Risky for personal safety 

B. Fine to share with everyone 

C. Needed for all posts 

D. Done without thinking  

लाइव लोकेशन पोस्ट करना- 

A. व्यस्िगत सुरिा के मलए िोस्खम भरा है 

B. सभी के साथ साझा करना ठीक है 

C. सभी पोस्ट के मलए आवश्यक है 

D. मबना सोचे-समझे मकया गया है  

 

*********************** 

 

 

 


